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Abstract 

 

The Faculty of Fisheries and Marine at Airlangga University in Surabaya City belongs to one of the 

educational facility buildings developed in 2014. The construction of the building referred to the 

regulations of SNI 1726-2002 for earthquakes, SNI 03-2847-2002 for concrete structures, and 

PPIUG 1983 for loading. This condition needs to be considered as educational buildings are the 

main and vital physical infrastructures for humans to seek knowledge and work. In this study, a 

pushover analysis was carried out to determine the structural level, referring to the ATC-40 ductility 

that occurred after the evaluation. After employing the rules of SNI 1726-2012 for earthquakes, SNI 

03-2847-2013 for structural element design, and SNI 1727-2013 for loading, this research obtained 

a displacement value of 0.231, meaning that the displacement performance of the building was good. 

Furthermore, the maximum drift was 0.00546 and the maximum inelastic drift gained 0.005, 

signifying the performance criteria of IO (Immediate Occupancy). Thus, when an earthquake occurs, 

only a small amount of structural damage will exist. Since the ductility of the FPK building was 1.2, 

it belonged to level 1 (elastic structure). 

Keywords: Pushover Analysis, ATC-40, Inelastic Joint 

 

Abstrak 

 

Fakultas Perikanan dan Kelautan Universitas Airlangga yang terletak di Kota Surabaya merupakan 

salah satu gedung sarana pendidikan yang dibangun pada tahun 2014. Dimana pembangunan gedung 

tersebut mengacu pada peraturan SNI 1726-2002 untuk gempa, SNI 03-2847-2002 untuk struktur 

beton, dan PPIUG 1983 untuk pembebanan.. Kondisi ini perlu diperhatikan , mengingat bangunan 

pendidikan merupakan prasarana fisik utama yang penting bagi manusia, sebagai tempat untuk 

mencari ilmu dan bekerja. Pada penelitian ini dilakukan analisis pushover untuk mengetahui kriteria 

level struktur yang mengacu pada ATC-40 daktilitas yang terjadi setelah dilakukan evaluasi. Aturan 

yang dipakai yaitu SNI 1726-2012 untuk gempa, SNI 03-2847- 2013 untuk desain elemen sreuktur 

dan SNI 1727-2013 untuk pembebanan. Maka didapatkan nilai Displacement 0,231 yang berarti 

kinerja dicplacement gedung baik, maksimal drift 0,00546 dan maksimal In elastic Drif 0,005 

termasuk dalam kriteria kinerja IO (Immediate Occupancy) yang berarti bila terjadi gempa, hanya 

sedikit kerusakan structural yang terjadi.Serta daktilitas pada gedung FPK ini yaitu 1,2 tergolong 

pada tingkat 1 (struktur elastis). 

Kata kunci: Dinding Geser, Perilaku Struktur, Ketidakberaturan. 
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1. Pendahuluan 
Indonesia terletak di daerah rawan gempa, untuk mengurangi resiko akibat bencana gempa tersebut 

perlu direncanakan struktur bangunan tahan gempa. Berdasarkan data gempa terbaru yang terjadi di 

Aceh , Jogja dan daerah lainya para ahli dibawah kordinasi KPUPR mengeluarkan peta gempa 2017 

[1]. Peraturan perencanaan struktur gedung tahan gempa di Indonesia mengalami perkembangan 

seiring terjadinya gempa besar , dari SNI 1726-2002 dimana terdapat 6 area spektrum gempa 

dikembangkan menjadi SNI 1726-2012 yang membagi Indonesia menjadi 15 area spektrum yang 

berbeda. Dengan adanya peraturan terbaru maka perlu dilakukan evaluasi kinerja struktur pada 

gedung-gedung yang temasuk dalam faktor keutamaan tinggi yaitu gedung sekolah dan fasilitas 

pendidikan, untuk memperkecil resiko kerusakan bangunan akibat bencana gempa [2]. 

Menurut Wiryanto Dewobroto (2005), keamanan dan keselamatan bangunan tidak hanya bergantung 

pada tingkat kekuatan, tetapi juga pada tingkat deformasi dan energi struktur pada kinerja struktur. 

Salah satu metode analisa untuk mengetahui kinerja struktur, yang dapat digunakan adalah analisis 

dinamik non linear atau analisis pushover . Ada 3 macam metode untuk menentukan kriteria Level 

kinerja yaitu : Applied Technology Council (ATC-40), Failure Mode Effect Analysis (FEMA 356), 

dan Failure Mode Effect Analysis (FEMA 440).Namun untuk menentukan evaluasi kinerja struktur 

berbasis performance point berdasarkan ATC-40 [3][4].  

Analisa pushover adalah salah satu komponen performance based seismic design yang 

memanfaatkan teknik analisa non-linier berbasis komputer untuk menganalisis perilaku in-elastis 

struktur dari berbagai macam in-tensitas gerakan tanah (gempa) [5], dengan memberikan beban statik 

tertentu dalam arah lateral yang besarnya ditingkatkan secara bertahap (incremental) sampai struktur 

tersebut mencapai target displacement tertentu atau mencapai pola keruntuhan tertentu [6]. Hasil 

akhir dari analisis ini didapatkan kurva kapasitas struktur (capacity curve) yang menggambarkan 

hubungan antara gaya geser dasar (base shear) dan perpindahan atap (roof displacement). Melalui 

kurva kapasitas tersebut dapat diketahui kinerja dari struktur gedung yang dianalisis. Selain itu, 

analisa pushover juga dapat memperlihatkan secara visual perilaku struktur pada saat kondisi elastis, 

plastis dan sampai terjadinya keruntuhan pada elemen-elemen strukturnya. Metode analisa pushover 

bisa menghasilkan informasi yang sangat bermanfaat karena mampu menggambarkan respons in-

elastis bangunan ketika mengalami gempa. Berdasarkan data tersebut, penulis akan mengevaluasi 

kinerja struktur gedung Fakultas Perikanan dan Kelautan Universitas Airlangga Surabaya 

menggunakan analalis pushover berdasarkan ATC-40 [4]. 

 

2. Metode Penelitian 

Adapun bagan alir untuk melakukan analisis, seperti yang tertera pada Gambar 1 : 

 

Gambar 1. Flowchart Penelitian. 
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3. Hasil dan Pembahasan 

3.1. Menentukan Jenis Tanah (Site Class) 

Untuk data tanah menggunakan sesuai data eksisting yang ada. Didapat data sebagai berikut : 

 

Tabel 1.  Data Tanah Eksisting 
No. Depth Ti Ni-SPT Ti/Ni 

 (m) (m)   

1 1,25 2 0 0 

2 3,25 2 3 0,667 

3 5,25 2 0 0 

4 7,25 2 0 0 

5 9,25 2 0 0 

6 11,25 2 0 0 

7 13,25 2 0 0 

8 15,25 2 16 0,125 

9 17,25 2 12 0,167 

10 19,25 2 43 0,046 

11 21,25 2 47 0,042 

12 23,25 2 50 0,040 

13 25,25 2 28 0,071 

14 27,25 2 33 0,060 

15 29,25 2 38 0,526 

16 31,25 2 12 0,167 

17 33,25 2 50 0,040 

18 35,25 2 30 0,066 

19 37,25 2 23 0,086 

20 39,25 2 25 0,080 

Total 2,183 

Nrata-rata (39,25/Total) 17,97 

 

Dari hasil perhitungan nilai N rata-rata sebeshar 17,97 dari Tabel 2.6 termasuk dalam klasifikasi 

situs dengan jenis tanah sedang (SE) dengan nilai 15 – 50. 

 

3.2. Menentukan Parameter Gempa 

Dilihat pada tabel 2.4 kategori risiko bangunan gedung untuk beban gempa, bangunan Fakultas 

Perikanan dan Kelautan Unair termasuk pada kategori risiko IV karena termasuk dalam kategori 

gedung sekolah dan fasilitas pendidikan. Nilai Faktor R=8 , Cd=5,5 ; dan Ώ0=3. Nilai Ie = 1,5; 

Parameter percepatan gempa Ss (T=0,2 detik)= 0,6881 dan S1 (T=1,0 detik)= 0,3 ; Fa= 1,4; Fv= 

2,88; SMS= Fa.Ss = 0,9633; SM1= FV.S1 = 0,864; SDS= 2/3 SMS= 0,6422; SD1= 2/3 SM1=  

0,876;  dan spektrum respon = 0,2 ( SD1/SDS) = 0,1746 sec. Dengan grafik respon spektranya 

seperti pada Gambar 2. 
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Gambar 2. Hasil perhitungan Program Desain Spektra Indonesia. 

 

Koefisien Respon Seismik (Cs) 

Koefisien respons seismik, Cs, harus ditentukan sesuai dengan SNI 03-1726-2012 pasal 

7.8.1.1 

SDS = 0,6422 ; SDI = 0,876;  Ie = 1,50 ; R = 8 (SRPMK) 

 𝐶𝑠 =
𝑆𝐷𝑆

𝑅

𝐼𝑒

 =  0,12   dan Nilai  Cs tidak lebih dari   𝐶𝑠 =
𝑆𝐷1

𝑇𝑎(𝑅/𝐼)
=  0,1946 

Dan nilai Cs tidak kurang dari : 

𝐶𝑠 = 0,044𝑆𝐷𝑆𝐼𝑒 =0,0423 ≥ 0,01 

Maka nilai Cs diambil 0,120 untuk gempa 100 % 

3.3. Kombinasi Pembebanan dan Kontrol Struktur Gedung 

Struktur, komponen, dan fondasi harus dirancang sedemikian rupa sehingga kekuatan desainnya 

sama atau melebihi efek dari beban terfaktor dalam kombinasi yang mengacu berdasarkan SNI 

03 1727:2013 yaitu 

1) 1,4 DL 

2) 1,2 DL+ 1,6LL 

3) 1,2 DL + 1,6 LL ± 1 Ex ± 0,3 Ey 

4) 1,2 DL+ 1,6 LL ± 0,3 Ex ± 1 Ey 

5) 0,9 DL ± 0,3 Ex ± 1 Ey 

6) 0,9 DL ± 1 Ex ± 0,3 Ey 

 

• Kontrol Terhadap Beban Gempa 

Setelah dilakukan pembebanan sesuai SNI 1726-2012 terhadap model struktur eksisting, 

maka dilakukan analisis dengan menggunakan SAP2000, untuk meninjau kelayakan struktur 

dalam memikul beban-beban yang bekerja. Dari hasil analisis struktur tersebut harus 

dikontrol melalui batasan-batasan berikut : 

 

Tabel 2. Perhitungan Gaya Axial Pada Kolom 
Element Depth Ti Ni-SPT Ti/Ni 

 (m) (m)   

1 1,25 2 0 0 

2 3,25 2 3 0,667 

3 5,25 2 0 0 

4 7,25 2 0 0 

5 9,25 2 0 0 

6 11,25 2 0 0 

7 13,25 2 0 0 

8 15,25 2 16 0,125 

9 17,25 2 12 0,167 
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Element Depth Ti Ni-SPT Ti/Ni 

 (m) (m)   

10 19,25 2 43 0,046 

11 21,25 2 47 0,042 

12 23,25 2 50 0,040 

13 25,25 2 28 0,071 

14 27,25 2 33 0,060 

15 29,25 2 38 0,526 

16 31,25 2 12 0,167 

17 33,25 2 50 0,040 

18 35,25 2 30 0,066 

19 37,25 2 23 0,086 

20 39,25 2 25 0,080 

Total 2,183 

Nrata-rata (39,25/Total) 17,97 

 

Nilai ini masih berada dibawah batas selisih toleransu berat bangunan, yaitu 5% . Maka untuk 

model yang telah dibuat dapat digunakan dengan bantuan program SAP 2000. Kontrol 

Periode Alami Struktur T = Ta . Cu. 

 

• Periode fundamental pendekatan (Ta)  

𝑇𝑎 =
0,0062

√𝐶𝑤

ℎ𝑛 

Cu = 1,4 (SNI 03-1726-2012 pasal 7.8.2 

𝐶𝑤𝑦 =
100

𝐴𝑔

𝛴𝑖=1
𝑥 (

ℎ𝑛

ℎ𝑖

)
2 𝐴𝑖

[1 + 0,83 (
ℎ𝑖

𝐷𝑖
)

2

]

= 0,000312 𝑑𝑎𝑛 𝐶𝑤𝑥 =  0,000377 

Tay=0,877 dan Tax =0,798  

 

Kontrol Partisipasi Massa 

Menurut SNI 1726:2012 Pasal 7.9.1, bahwa analisa harus menyertakan jumlah ragam yang 

cukup untuk mendapatkan partisipasi massa ragam terkombinasi sebesar paling sedikit 90 % 

(Tabel  3).  

Tabel 3. Kontrol Partisipasi Massa 

Mode Period UX UY SumUX SumUY 

1 0.970021 0.272790 0.086840 27 % 9 % 

2 0.899642 0.062610 0.714720 34 % 80 % 

3 0.415034 0.446600 0.007260 78 % 81 % 

4 0.298025 0.038910 0.006510 82 % 82 % 

5 0.272903 0.004890 0.094430 83 % 91 % 

6 0.225292 0.008760 0.000670 83 % 91 % 

7 0.222047 0.000110 0.022130 83 % 93 % 

8 0.201651 0.001390 0.000024 84 % 93 % 
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Mode Period UX UY SumUX SumUY 

9 0.194155 0.000095 0.000260 84 % 93 % 

10 0.160094 0.013690 0.001010 85 % 93 % 

11 0.134610 0.001680 0.038860 85 % 97 % 

12 0.133319 0.007310 0.000000 86 % 97 % 

13 0.127630 0.006420 0.000210 87 % 97 % 

14 0.126247 0.087270 0.000047 95 % 97 % 

 

 

• Kontrol Base Reaction 

Nilai Vdinamik dan Vstatik didapatkan dari base reaction hasil analisa struktur. Pada SNI 

03-1726-2012 pasal 7.9.4 memsyaratkan nilai akhir Vdinamik minimal 85% dari Vstatik 

(Vdinamik ≥ 0,85 Vstatik). Bila syarat ini tidak terpenuhi maka gaya geser dasar ragam perlu 

dikalikan faktor skala gaya sebesar 0,85 V/Vt (SNI 03-1726-2012 pasal 7.9.4.1) 

 

Tabel 4. Kontrol nilai akhir respons spectrum 

TIPE BEBAN GEMPA FX FY 

RSPX 554769,72 166130,68 

RSPY 124958,00 554755,25 

 

Diketahui V static dari SAP2000 yaitu : 652648,02 kg Arah x : 

Vdinamik ≥ 0,85 Vstatik 

554769,72 kg ≥ 0,85 x 652648,02 kg 

554769,72 kg > 554750,82 kg  ➔ maka OK 

Arah y : 

Vdinamik ≥ 0,85 Vstatik 

554769,72 kg ≥ 0,85 x 652648,02 kg 

554755,25 kg > 554750,82 kg  ➔ maka OK 

Dari hasil di atas dapat disimpulkan bahwa nilai akhir dari respon spektrum telah memenuhi 

SNI 03-1726-2012 pasal 7.9.4.1, maka pengaruh gempa dinamik lebih menentukan. Maka 

pada tahap perencanaan struktur akan digunakan beban gempa dinamik. 

  

• Kontrol Simpangan 

Untuk kontrol drift pada SNI 03-1726-2012 dirumuskan sebagai berikut : 

𝛿𝑥 =
𝐶𝑑. 𝛿𝑥𝑒

𝐼𝑒
 

Di mana : 

δx = defleksi pada lantai ke-x 

Cd = faktor pembesaran defleksi (= 5,5) SNI 03-1726-2012 Tabel 9 

I = faktor keutamaan gedung (= 1,5) 

Untuk struktur SRPMK, menurut SNI 03-1726-2012 pasal 7.12.1 tabel 16, simpangan 

dibatasi sebesar : 

Δmax = 0,01hsx =  0,01 x 3200 = 32 mm, untuk tingkat 1 

Δmax = 0,01 hsx =  0,01 x 4000 = 40 mm, untuk tingkat 2 - 11 (atap)  
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Tabel 5. Konrol Drift Arah x Tiap Lantai 

 

Lantai 

hi δxe δx 

Drift Syarat 

 

Ket 

(Δs) Drift Δs 

m mm mm mm mm 

10 42,3 6,26 22,97 -51,79 40 OK 

9 37,7 11,56 27.54 20.65 40 OK 

8 32,7 15,98 60,08 38,01 40 OK 

7 30,5 19,02 74,75 38,66 40 OK 

6 27,9 20,39 74,75 37,38 40 OK 

5 23,1 10,19 37,38 5,00 40 OK 

4 18,3 10,19 37,38 5,63 40 OK 

3 13,5 8,66 31,74 11,49 40 OK 

2 8,7 5,52 20,26 11,84 40 OK 

1 5,5 2,30 8,42 8,42 32 OK 

0 0,00 0,00 0,00 0,00 32 OK 

 

Tabel 6. Kontrol Drift Arah y Tiap Lantai 

 

Lantai 

hi δxe δx 

Drift Syarat 
 

Keteran

gan 

(Δs) Drift Δs 

m mm mm mm mm 

10 42,3 150.01 551,9 36,85 40 OK 

9 37,7 138,90 501,0 36,85 40 OK 

8 32,7 130,88 490,11 36,85 40 OK 

7 30,5 122,32 448,52 34,75 40 OK 

6 27,9 101,94 373,77 34,75 40 OK 

5 23,1 81,55 299,01 34,75 40 OK 

4 18,3 61,16 224,26 34,75 40 OK 

3 13,5 40,77 149,51 37,38 40 OK 

2 8,7 30,58 112,13 35,96 40 OK 

1 5,5 9,87 36,17 26,17 32 OK 

0 0,00 0,00 0.00 0,00 32 OK 
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3.4. Analisis Statis Nonlinear Pushover 

Analisis pushover atau beban dorong diberikan dengan menentukan titik berat gedung di puncak 

bangunan, pada keempat model banguan. Metode yang digunakan dalam ATC-40 adalah 

Spektrum kapasitas (capacity-spectrum). Metode spektrum kapasitas adalah dengan 

memplotkan demand respon spektrum dan kurva kapasitas dalam satu format antara spektral 

percepatan vs spektral perpindahan atau disebut sebagai format Acceleration-Displacement 

Response Spectra (ADRS). 

 

Membuat Nonlinier Case 

a) Menentukan Gravity Nonlinier CasePilih Define > Load case, lalu akan muncul boxes 

Define Load Cases seperti terlihat pada Gambar 3. 

b) Pilih Add New Case, maka akan muncul Load Case Data Linier Static lalu isikan data 

seperti terlihat pada Gambar 3. 

c) Dalam hal ini prosentase beban yang digunakan dalam analisa pushover yaitu 100% beban 

mati (termasuk beban mati tambahan) dan 50% beban hidup. Selain itu efek P-Delta harus 

ditambahkan karena pada analisa pushover Displacement yang terjadi akan terus 

bertambah seiring dengan penambahan beban dorong statik yang diberikan pada bangunan. 

Gambar 3. Define Load Cases. 

 

Menentukan Nonlinier Pushover Case 

a) Pilih Define > Load Case > Add New Load Case dan isikan Static Nonlinier Case Name = 

PUSHX. 

b) Isikan Push to Disp. Magnitude = - 1, dan centang pada Use Conjugate Displ. For control. ( 

data tersebut dipilih untuk memonitor deformasi pada struktur gedung dengan mencatat 

perpindahan bangunan atau displacement selama proses analysis pushover dengan 

maksifmum displacement yang akan dihitung oleh program sebesar 1 (satu) meter. 

c) Isikan Load to Monitored Displacement Magnitude of = 846 (Monitires displacement 

diambil 2% dari tinggi gedung) 

d) Pada option DOF pilih U1 dan Input at Joint = 773 dan klik OK 

 

Memodelkan Sendi Plastis 

Untuk analisis Pushover hal lain yang juga perlu diperhatikan adalah permodelan sendi plastis 

(plastic hinges) pada elemen struktur yang dibuat. pendifinisian sendi plastis ini didasarkan pada 

perilaku struktur yang didesain. Perilaku struktur yang dimodelkan. Dalam hal ini struktur akan 

berperilaku sebagai Beam Sway Mechanism, yang artinya ketika struktur terkena beban lateral 

maka balok akan terlebih dahulu mengalami kelelehan pada ujung-ujung balok tersebut 

kemudian dilanjutkan dengan kelelehan pada kolom pada pangkal kolom. Langkah- langkah 

untuk mendefinisikan sendi plastis ditunjukkan dibawah ini : 

a) Sendi Plastis pada Balok. Pilih semua elemen balok induk dan balok anak pada semua lantai. 

b) Pilih Assign > Frame > Hinges, lalu akan muncul boxes Assign Frame Hinges. Masukkan 

data sesuai Gambar 4. 
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c) Sendi plastis pada kolom. Pilih semua elemen pada seluruh lantai. 

d) Pilih Assign > Frame > Hinges, lalu akan muncul boxes Assign Frame Hinges. Masukkan 

data sesuai Gambar 5. 

e) Run Program pada menu Analyze > Run Analysis. Lalu setalah selesai, Run Static Nonlinier 

Analysis dengan pilih pada menu Analyze > Run Static Nonlinear Analysis. 
a.  

  

Gambar 4. Input Hinge pada Balok 

 

Gambar 5. Input Hinge pada Kolom 

3.5. Kurva Kapasitas Pushover 

Setelah selesai proses Static Nonlinear Analysis. Untuk menampilkan hasil dari analisa tersebut 

berikut langkah-langkah : 

 

a) Pilih Display > Show Static Pushover Curve maka akan muncul boxesbaru. 

b) Pilih options Static Nonlinier Case pilih PUSHX untuk Pushover Curve arah x-x dan PUSHY 

untuk Pushover Curve arah y-y, terlihat pada Gambar 

c) untuk menampilkan plot-plot kurva pushover maka pilih File > Display Table maka akan 

muncul plot-plot gaya beserta  perpindahannya untuk setiap step beban dorong. 
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Gambar 4.18 Pushover Curve-x dan Curve-y. 

 

Lalu untuk menampilkan titik kinerja struktur terlebih dahulu harus memasukan beberapa 

parameter-parameter yang dihitung dan sesuai dengan dokumen ATC-40. Berdasarkan 

ATC-40 pasal 4.4.3.1 dapat dihitung parameter nilai CA dan Cv sebagai berikut : 

CA = 0,4 . Sms = 0,38 dan  Cv = Sm1 = 0,86 

Untuk Damping parameter isikan nilai 0,05 atau 5 % (natural damping pada bangunan 

beton bertulang). 

 

Gambar 4.24 Spektrum Kapasitas Arah X-X. 

Tingkat Kinerja Struktur 

Setelah dilakukan analisa pushover pada program SAP 2000 maka Level kinerja bangunan 

terhadap gempa mengacu pada IO (Immediate Occupancy), DC (Demage Control), LS (Life 

Safety), dan CP (Collapse Prevention) diperoleh hasil sebagai berikut : 

V = 87763,581 Kn ; D= 0,231 m; Sa= 0,549 m  dan Sd = 0,115 m 

Displacment Limit (SNI 1726-2012) = 2% 

H = 0,02 x 42,3 = 0,846 m > D = 0,231m maka kinerja displacement gedung baik. 

Kinerja gedung menurut ATC – 40 Tabel 11-12 
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Maksimal 𝐷𝑟𝑖𝑓𝑡 =  
𝐷

𝐻
=

0,231

42,3
= 0,00546 

Sehingga level kinerja gedung adalah Immediate Occupancy. 

Maksimal In elastic   𝐷𝑟𝑖𝑓𝑡 =  
𝐷1

𝐻
=

0,231−0,0992

42,3
= 0,005 

Sehingga level kinerja gedung adalah Immediate Occupancy. 

Daktilitas Struktur 

Struktur daktail adalah struktur yang mampu mengalami simpangan pasca elastis yang besar 

secara berulang kali dan bolak-balik akibat gempa yang menyebabkan terjadinya pelelehan 

pertama, sambil mempertahankan kekuatan yang cukup, sehingga struktur tetap berdiri, 

walaupun sudah berada di ambang keruntuhan. Faktor daktilitas gedung adalah rasio antara 

simpangan maksimum pada ambang keruntuhan dengan sempangan pertama yang terjadi 

pada pelelehan pertama. Daktilitas struktur dapat dirumuskan sebagai berukut : 𝜇 =
𝛿𝑚

𝛿𝑢𝑦
=

0,444

0,2529
= 1,2 

Dimana:  u = daktilitas struktur 

  δm = mengalami keruntuhan 

  δy = leleh pertama 

Tingkat 1 (struktur elastis), yaitu dimana sturktur didesain sedemikian rupa sehingga dapat 

mmenuhi persyaratan penyelesaian detail strukur yang ringan dimana stuktur akan menerima 

gaya gempa secara elastis, dengan nilai factor daktilitas sebesar 1,0. 

 

4. Kesimpulan 

Berdasarkan evaluasi kinerja struktur beton pada gedung Fakultas Perikanan unair didaptkan 

tingkat kinerja sebagai berikut : 

1) Nilai displacement untuk Gedung FPK adalah = 0,231m maka kinerja displacement gedung 

baik. 

2) Level kinerja struktur yang terjadi setelah menggunakan analisis Pushover adalah Maksimal 

Drift = 0,00546 (Immediate Occupancy). Maksimal In elastic Drif = 0,005 (Immediate 

Occupancy). Bila terjadi gempa, hanya sedikit kerusakan struktural yang terjadi. 

Karakteristik dan kapasitas sistem penahan gaya vertikal dan lateral pada struktur masih 

sama dengan kondisi dimana gempa belum terjadi, sehingga bangunan aman dan dapat 

langsung dipakai. 

3) Dari hasil Daktilitas struktur yang terjadi setelah menggunakan analisis Pushover adalah 

termasuk dalam kategori daktilitasTingkat 1, (daktilitas elastis) yaitu dimana sturktur 

didesain sedemikian rupa sehingga dapat mmenuhi persyaratan penyelesaian detail strukur 

yang ringan dimana stuktur akan menerima gaya gempa secara elastis, dengan nilai factor 

daktilitas sebesar 1,0. 
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